
1, 2, ... commands (Window menu)

FillPower PRO displays a list of currently open form windows at the bottom of the Window 
menu. A check mark appears in front of the form name of the active window. Choose a form 
from this list to make its window active.



1, 2, 3, 4 commands (File menu)

Numbers and file names listed near the bottom of the File menu list the last four forms you 
opened. Choose the number that corresponds to the form you want to open, or click on the 
name with the left mouse button.



About command (Help menu)

Displays the copyright notice and version number of your copy of FillPower PRO™.

FillPower PRO™    is    © 1994,96 by EZX Corporation, all USA and 
International rights reserved.

Distributed by:
EZX Corporation
“The Forms Automation Comapny”
403 E. NASA Rd., Suite 377
PO Box 58177    -    FIP96e
Webster (Houston), TX    77598-8177    USA

Credit Card Orders (Visa, MasterCard, Discover, American Express) may call the 
ORDER DESK @ 1.800.800.2H4O6T8 (toll free in the USA)
(There is a per-minute charge for service/support calls to the above number.)

Technical Support:
Voice: +1-713-280-0080 (9:00am - 4:00pm    Central    USA    M - F)
EZ-Host! BBS: +1-713-280-8180 (E-mail; Support, etc. 24hrs. per day)
Internet: ezx@cris.com    or    EZXHOU@aol.com (E-mail)
AmericaOnLine: EZXHOU (E-mail)
CompuServe: 76350,3111 (E-mail)
World Wide Web: http://www.cris.com/~ezx or    http://home.aol.com/EZXHOU

For all other business and International:
Voice: +1-713-280-9900 (Questions, Comments, observations, & 

support.)
FAX: +1-713-280-0099 (Inbound FAXes; 24hrs per day.)



 Note, our Area Code may change around Nov'96.
    If 713 does not get thru, dial 713-555-1212
    and ask for EZX Corporation's phone number
    and area code. Thank-you Texas PUC?



Arrange Icons command (Window menu)

Use this command to arrange icons for minimized windows at the bottom of the FillPower PRO 
main window. If there is an open form window covering the bottom of the main window, then 
some or all of the icons may not be visible because they will be behind this form window.



Calculate command (Field menu)

When a calculation exists for the current field, this command will process that calculation. A field
calculation is created by the form designer in order to make form fillout easier, quicker and more
accurate. Otherwise calculations would have to be carried out manually.

The calculation for the current field is automatically processed when the cursor is moved to the 
next field, so this command is only necessary when you don't want to move to the next field 
prior to seeing the results. This situation may arise when the next field is outside of the viewable
window.

Errors can occur during field calculation, such as divide by zero, underflow or invalid function 
parameters. Any errors will result in an error message displaying the expression and the field 
name of occurrence.

Shortcut
Toolbar:



Cascade command (Window menu)

Use this command to arrange multiple open windows in an overlapped fashion.



Clear All (Edit menu)

Design Mode
This provides a quick and convenient way to clear all objects in a form. Prompts for confirmation
first. The resulting form is blank, identical to the blank form created by the Form-New command.

Fillout Mode
This provides a quick and convenient way to clear the contents of all fields in a form. Prompts 
for confirmation first. The resulting form has all blank fields.

See Also

Edit Fillout Next



Close command (Control menus)

Use this command to close the active window or dialog box.
Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open, the Close command on the form Control menu 
closes only one window at a time. You can close all windows at once with the Close-All 
command in the Window menu.

Shortcut
Keys: Ctrl + F4 Close a form window.

Alt + F4 Close a dialog box



Close command (File menu)

Use this command to close an active form window. When the form is modified, a save 
prompt will appear. If you close a modified form without saving it, you lose all changes 
made since the last time you saved it. Before closing an untitled form, FillPower PRO 
displays the Save As dialog box and suggests that you name and save the form.

You can also close a form by double-clicking the Close icon on the form's window, as 
shown below:



Close All command (Window menu)

Use this command to close all open windows including those that have been iconized. You will 
be asked if you want to save any unsaved forms before closing them.



FillPower PRO™      FormTrooper PRO Edition
© 1994,96 by EZX Corporation
“The EZ-Forms Automation Company”
Release 96e        Released May 1996

NOTE:
Special versions of FillPower PRO specifically tied to custom developed forms, are the 
“engines” that drive products like YourForms™, ExportPower™, WinDD250™, 
FormTrooper™, WinSF171™, AnyPower™, MedTrakker™, KidTrakker™,    
ExpenseTrakker™, PackageTrakker™, etc.
 

Introduction
Installation
Getting Started
Overview
What's New
Troubleshooting
Keyboard Commands
Error and Warning Messages
License

FillPower™ is the Ultimate Forms Filler for Windows!

NOTE: FillPower PRO™ is a subset of FormPower PRO™.
For more information, contact EZX Corporation at 713-280-9900    FAX:
713-280-0099.
                                Please ignore any obvious references fo FormPower.

Should you require a special “sub-published” edition of FillPower PRO customized for 
you and your special form or application, contact EZX at the address and numbers 
below.

Call for Multi-user, LAN, Server, Site, Regional and Corporate licensing.

Ask about upgrade, competitive, and introductory pricing.

Also ask about custom design and “sub-publishing” services.

Specifications, pricing, etc. are subject to change without notice.

Thank you for using FillPower PRO™ for Windows © 1994,96 by and from:    (All rights 
reserved.)

EZX Corporation



“The Forms Automation Company”
403 E. NASA Rd., Suite 377
PO Box 58177    -    FIP96e
Webster (Houston), TX    77598-8177    USA

Technical Support:
Voice: +1-713-280-0080 (9:00am - 4:00pm    Central    USA    M - F)
EZ-Host! BBS: +1-713-280-8180 (E-mail; Support, etc. 24hrs. per day)
Internet: ezx@cris.com    or    EZXHOU@aol.com (E-mail)
AmericaOnLine: EZXHOU (E-mail)
CompuServe: 76350,3111 (E-mail)
World Wide Web: http://www.cris.com/~ezx or    http://home.aol.com/EZXHOU

For all other business and International:
Voice: +1-713-280-9900 (Questions, Comments, observations, & 

support.)
FAX: +1-713-280-0099 (Inbound FAXes; 24hrs per day.)



Control menu (Form window)
The main FillPower PRO window and the Form and Dialog box windows all have a control menu
tab in the top left corner. Double-clicking on the tab is the same as selecting Close from the 
menu.

Restore Restores the window.
Move Repositions the window.
Size Adjust the window size.

Minimize Iconize the window.
Maximize Expand the window.

Close Closes the window.
Next From control tab.

Switch to another open form within FillPower 
PRO.



Control menu (Main window)
Top Left tab on Program, Form and Dialog box windows. Double-clicking on the tab is the same 
as selecting Close from the menu. Double-click on the Control tab, or use key combination Alt + 
F4 to close the program window, or any displayed dialog boxes.

Restore Restores the window.
Move Repositions the window.
Size Adjust the window size.

Minimize Iconize the window.
Maximize Expand the window.

Close Closes the window.
Switch To Program control tab.

Switches to another program.



Copy command (Edit menu)

Use this command to copy the currently selected (highlighted) object or text from the form and 
put it into Windows' clipboard. The Paste command can then be used to copy the clipboard 
contents to another form, or to elsewhere on the same form.

This command is unavailable if no object or text is selected.

Copying data to the Windows clipboard always replaces any previously stored contents.

Shortcut
Toolbar:
Keys: Ctrl + C



Current field does not pass designer validation criteria.
Fillout mode

This is the default error message given when a field's contents does not pass field validation. 
The form designer sets up the field validation criteria.



Cut command (Edit menu)

Use this command to remove the currently selected (highlighted) object or text from the form 
and put it into Windows' clipboard. The Paste command can then be used to copy the clipboard 
contents to another form, or to elsewhere on the same form.

This command is unavailable if no object or text is selected.

Cutting data to Windows' clipboard always replaces any previously stored contents.

Shortcut
Toolbar:
Keys: Ctrl + X



Text Feed-Date (Edit menu) & Date (Field menu)

Quickly insert system Date into a field during data entry.using Ctrl + D. Any text that may 
already be in the field will be overwritten. You will not be able to insert into the middle of a 
sentence or phrase.

The format for Text Feed Date is controlled by the Windows' Control Panel International 
settings.

Shortcut
Toolbar:
 Keys: Ctrl + D



Delete Command (Edit menu)

Use the Del key, or the Edit-Delete command to delete the currently selected object from the 
form.

While entering text in design mode or during fillout mode, this command will delete selected text
or the character to the right of the cursor.



Error and Warning Messages
Select one of the following error or warning message topics. Each will specify whether it applies 
to design mode, fillout mode, or both. Where possible, remedies are given.

Server is still busy.

There are no fields in this form. Fillout cancelled.

Save option settings?

Save this form before continuing.

Are you sure you want to clear the entire form?

Cut to clipboard failed.

Copy to clipboard failed.

Failed to paste object from clipboard.

Failed to create object.

Item on the clipboard has zero size.

Failed to initialize OLE2 libraries.

Error loading EZX1.DLL

Error opening graphic file

This single-user version of FillPower PRO cannot access network drives. Please contact EZX 
for network pricing information.

This single-user version of FillPower PRO cannot run from a network drive. Please contact EZX 
for network pricing information.

Error setting system timer.

The FillPower PRO executable file exhibits evidence of tampering. Unable to continue. Reinstall
from original disks.

Please enter a number between .02 and 25.4 cm.

Please enter a number between .05 and 2.54 cm.

Please enter a number between 5.08 and 76.2 cm.

Calculation yields invalid date.

Calculation yields a number that is too small or too large.



Error in calculation.

Test OK. The expression result is of type: ??.

Test OK. The expression has a Logical type result.

Error: the validate expression does not evaluate to a Logical type value (for example, qty<100). 
Furthermore in fillout, the result must be True.

Current field does not pass designer validation criteria.

Invalid field name. Characters in name must be alphanumeric or _.

Calculation results in a type that does not match field.

The form orientation does not match the printer orientation setting. Continue printing?

Invalid date value.

Error reading auto number file.

Invalid number and/or format.

Error reading pick list file.

Error reading field help file.

The help file is too long. Truncating view.



Error in calculation.
The calculation for the current field cannot be processed. This can be caused by invalid inputs 
or a flawed expression.



Error loading EZX1.DLL
This file is required for the operation of FillPower PRO. It should be located in your FillPower 
PRO subdirectory.

See Installation for a listing of program files required by FillPower PRO.



Error opening graphic file
File format may not be supported by Windows or FillPower PRO. If accessing file over a 
network, it may be in exclusive or restricted use by another client.



Error reading auto number file.
An auto number file was specified by the form designer, but it cannot be found or accessed. 
Unless the full path was given, auto number files must reside in the same directory as the form 
file itself.

See Also

Troubleshooting:



Error reading field help file.
A field help file was specified by the form designer, but it cannot be found or accessed. Unless 
the full path was given, field help files must reside in the same directory as the form file itself.

See Also

Troubleshooting:



Error reading graphic file
File format may not be supported by Windows or FillPower PRO. If accessing file over a 
network, it may be in exclusive or restricted use by another client.



Error reading pick list file.
A pick list file was specified by the form designer, but it cannot be found or accessed. Unless the
full path was given, pick list files must reside in the same directory as the form file itself.

See Also

Troubleshooting:



Error setting system timer.
Windows has apparently lost critical synchronization. Please save and close all applications, as 
well as Windows.

Remedy

Reboot your computer and restart Windows.



Calculation yields invalid date.
The date calculation for the current field results in a date that is not valid.



Copy to clipboard failed.
There may be too many open programs in Windows to complete the action. System resources 
may be low.

Remedy

Try shutting down some applications and then retry this action.



Cut to clipboard failed.
There may be too many open programs in Windows to complete the action. System resources 
may be low.

Remedy

Try shutting down some applications and then retry this action.



A field with this name already exists. Field names must be 
unique.
Design mode

Some other field in this form already has this name. Field names must be unique in order to 
ensure unambiguous calculations and validations.



The FillPower PRO executable file exhibits evidence of 
tampering. Unable to continue. Reinstall from original 
disks.
This error could occur after a system crash, unexpected power interruption, compression 
corruption, software virus attack, as well as many other sources. The program is no longer 
usable and must be reinstalled. The executable file has been corrupted. Copy your master 
forms (.FRM) and filled out forms (.FOF) to a secure floppy. Remove the FillPower PRO icons 
and group from Windows. Delete all other files relating to FillPower PRO. Then reinstall.

When reinstalling FillPower PRO, make sure the distribution disks are write protected. If a virus 
is suspected, run one of the many available anti-virus programs for a diagnosis.

Note: All EZX/SSW programs are virus free when shipped from EZX. As we have no control of 
their handling after leaving EZX, we disclaim all responsibility for same.



Failed to create object.
Design mode

The object type may not be assigned in the Windows registry profile (REG.DAT). You may need 
to edit the REG.DAT file via the Windows program REGEDIT.EXE.

Remedy

Reinstall the application needed to create the object you need.

Or, use REGEDIT.EXE to verify proper entries for this object type. Refer to Windows technical 
documentation.

Caution: Consult an experienced Windows user or consultant before attempting this. FillPower 
PRO automatically installs itself in the registry with the installation routines provided on the 
distribution disks. If you did not use the INSTALL program provided with FillPower PRO, the 
registry will not have been updated. Reinstall the proper way. Other programs may not 
automatically update the registry. Consult their respective publishers or distributors for help.



Failed to initialize OLE2 libraries.
Appropriate object linking and embedding files are not available.

Remedies

1) Look for multiple copies of any .dll file that start with "ole". There should only be one copy of 
any particular ole file on your system. Look in both your windows and windows\system 
directories for duplicate ole files. All ole*.dll files should be in the windows\system directory only.
If you are still experiencing this problem, continuing looking for duplicate dll's in directories 
specified in your DOS PATH environment variable.

2) Reinstall the application.



Failed to paste object from clipboard.
There may be too many open programs in Windows to complete the action. System resources 
may be low.

Remedy

Try shutting down some applications and then retry this action.



The text in help file ?? is longer than 1000 characters. 
Truncating view.
Field help text is limited to 1000 characters. When a field help file contains too much text, the 
extra is ignored.

Remedy

Edit the help file and remove all text beyond the first 1000 characters.



Invalid field name. Characters in name must be 
alphanumeric or _.
Design mode

Field names can only contain alphabetic or numeric characters or the underscore.

Valid Examples:

field001
country
phone_num

Invalid Examples:

field 001
>country
phone*num



Invalid date value.
When entering dates, the format must match what was specified in the Windows International 
Settings. These can be viewed or modified via the Windows Control Panel.

This error will also result when an invalid day, month or year is specified.



Invalid number and/or format.
Number Format:

{sign}{whole number digits}{.}{fractional digits}{E}{sign}{exponent}



Item on the clipboard has zero size.
The contents of the clipboard has been corrupted.

Remedy

Try pasting the original again. Make sure there are no programs running that deal with intensive 
tasks such as a spreadsheet recalculation, or image rendering. Processes that use a lot of 
computer or Windows system resources may restrict other program operations.



Please enter a number between .02 and 25.4 cm.
Design mode

You must enter the number within the given range.



Please enter a number between .05 and 2.54 cm.
Design mode

You must enter the number within the given range.



Please enter a number between 5.08 and 76.2 cm.
Design mode

You must enter the number within the given range.



This single-user version of FillPower PRO cannot access 
network drives. Please contact EZX/SSW for details on 
the network versions of FillPower PRO and pricing 
information.
Please contact EZX/SSW at 1.713.280.9900 (FAX: 1.713.280.0099) with your requirements, 
and we will forward a custom quotation addressing your particular network needs.



This single-user version of FillPower PRO cannot run from
a network drive. Please contact EZX/SSW for details on 
the network versions of FillPower PRO and pricing 
information.
Please contact EZX/SSW at 1.713.280.9900 (FAX: 1.713.280.0099) with your requirements, 
and we will forward a custom quotation addressing your particular network needs.



Calculation yields a number that is too small or too large.
The numeric calculation for the current field results in a number that cannot be represented or 
displayed.



Calculation results in a type that does not match field.
The results of a calculation must match the type of the field it is for.



Server is still busy.
FillPower PRO is currently processing an OLE function and the attempted operation is 
unsupported in this mode.

Remedy

Wait for the OLE function to complete.



There are no fields in this form. Fillout cancelled.
Design mode

To fill out a master form, it must either be loaded with the File Fillout command or converted by 
using the Edit Fillout command. In either case, if no fillout fields exist in the master form, fillout 
cannot proceed and this message will result.

Remedy

Use the Field drawing tool to create fields on the form.



Error: the validate expression does not evaluate to a 
Logical type value (for example, qty<100). Furthermore in 
fillout, the result must be True.
Design mode

When testing a validate expression during form design, this message will result when the 
expression does not evaluate to a Logical type.



Exit command (File menu)

Use this command to end your FillPower PRO session. You can also use the Close command 
on the FillPower PRO Control menu. FillPower PRO prompts you to save forms with unsaved 
changes.

Shortcut
Mouse: Double-click FillPower PRO's Control menu button.



Recalc All (Field menu)

Recalculate and revalidate all fields. This command is not always required, since validations 
and calculations are carried out as the cursor moves from field to field. They are again carried 
out whenever a form is committed to use, such as when it is saved or printed.

See Also

Process Dialog



Open / Fillout / Browse Dialog

Select a file to open by using the File-Open command for master or fillout forms. Master forms 
containing fields can be opened for fillout by using the File-Fillout command. At various other 
points in FillPower PRO, a Browse button is available to help locate a file of interest. The dialog 
window title will indicate which command was selected.

This dialog is the File Open common dialog used in most Windows programs.

File Name:
This area of the dialog box shows a listing of files available in the current subdirectory. If a tab is
in the scroll bar at the right edge of this area, use it to scroll through the file listing. Use 'List File 
of Type' to quickly choose what file types to show. Enter wildcard file names to control what files 
are shown.

Directories:
This section indicates the current subdirectory. Use the section below to change to a different 
subdirectory. Change subdirectories by using the scroll bar or double-clicking on a directory 
name. If a directory is not shown it may be located as a subdirectory below the one just above 
the current subdirectory. Try double-clicking on a directory name that is one or two levels above 
the current subdirectory.

List Files of Type:
Click on the arrow to change the type of files listed in the section just above.
Available choices are:
Master Forms. (*.frm)
Filled-Out Forms (*.fof)
All Forms (*.frm, *.fof)
All Files (*.*)

During Browse the file types may differ.

Drives:
Click on the arrow to display other available drives.

Network button
If you are connected to a network file server or workgroup, this button will activate your available
network services.
Note:    The single user version of FillPower PRO does not support network drive or services 
access even though the Network button may be active.



Fillout command (File menu)

Use the Fillout command to open a new window and load an existing Master Form that contains
field objects. This will cause creation of a corresponding Fillout Form file which you will be 
asked to name. The field objects in the Master Form now become data entry fields that can be 
filled out. You can open multiple forms simultaneously. Use the Window menu to choose the 
active form. See Window 1, 2, ... command.

Select the name of the form you want to open in the Fillout dialog box.

When a filled-out form is saved or printed, it is actually committed to use. This means that a 
form printout or a file will be presented to someone for actual use as a form. For example, an 
expense form is committed to use when it is presented to a manager for approval. An invoice 
form is committed to use when it is presented to a customer. To assure accuracy, FillPower PRO
will revalidate and recalculate all fields whenever committing a form to use. This processing can 
be overriden via the Process Dialog that appears when saving or printing a form.

Shortcut
Keys: Ctrl + F



Fillout Mode Overview
Click on an area of the dialog box for further explanation.



Fillout Next (Edit menu)

Fillout Mode

This command is useful when filling out a series of forms, all based on the same master form 
template. Fillout Next prepares for filling out the next form by clearing all fields and prompting for
a new filename. When enabled by the master form author, automated processing is done as 
well, such as auto number, date and time

If the current form is not saved, you are prompted to do so.

When a filled-out form is saved or printed, it is actually committed to use. This means that a 
form printout or a file will be presented to someone for actual use as a form. For example, an 
expense form is committed to use when it is presented to a manager for approval. An invoice 
form is committed to use when it is presented to a customer. To assure accuracy, FillPower PRO
will revalidate and recalculate all fields whenever committing a form to use. This processing can 
be overridden via the Process Dialog that appears when saving or printing a form.



Each form window title bar indicates the name of the open form in a highlighted color that is 
different from any other open form window.



An icon within the FillPower PRO client area (window) indicates an open form that has been 
minimized to clear the work space. The name of the opened form file is displayed below the icon
symbol. Several opened forms may be iconized at once in order to clean up the form display 
area. Double-click on the icon to bring the form back into the foreground and make it the active 
window.



Form design (Master Form) and data entry (Fillout Form) work area.



Getting Started
This documentation assumes a working knowledge of Windows and its user interface. Our on-
going goal is to always provide user interface ease, simplicity and consistency within FillPower 
PRO, as well as consistency with other Windows applications. This will serve to help you get 
started as quickly and easily as possible.

To get started, first learn the terminology, then read about what commands to begin with, then 
read about how FillPower PRO's on-line help is organized.

Terminology

Form
Master Form
Design Mode
Fillout Form
Fillout Mode
Object
Drawing Tool
OLE Object
Expressions

What to do

In FillPower PRO, you may be currently working in the Main Window without any active forms. 
Here are at least three ways to get started, listed here in order of complexity.

Note:    Some distribution sets do not contain the files mentioned. Please substitute for 
appropriate file types.

1) Load an existing master form in order to fill it out. Try expense.frm. You may need to change 
to a subdirectory named FIELDS. Use the File Fillout command, type

expense.frm
a dialog box appears asking for the name you want to give the new filled-out form. Type 
expense.fof then select OK. F1 will display fillout help. Now fill out some fields. When ready, 
save it with the File Save command.
2) Load an existing fillout form in order to fill it out or modify it. Try expense.fof. Use the File 
Open command, type

expense.fof
a dialog box appears asking for the name you want to give the new filled out form. Type either 
the same name to modify the existing form or any unique file name to create a different form, 
then select OK. F1 will display fillout help. Now fill out some fields. When ready, save it with the 
File Save command. Or use File Save As to save it with a different file name, leaving the original
file unchanged.
3) Create a new form with File New and design a new master form. Press F1 for design help. 
Select a drawing tool and place an object using the mouse. Place text, fields and graphics in the
same manner. When ready, save it with the File Save command and specify a unique name.

On-line Help



In general, on-line help is available at any time by pressing F1. The help that appears will be 
context sensitive, meaning that it will apply to the current place in FillPower PRO. Overall, there 
are three ways to access help. They are:

F1 Select a command, then press F1 to get context sensitive help.
Shift + F1 Press Shift + F1, then choose a screen element, toolbar button or menu item on 
which to get help.
Help menu Select a general topic.



Help command (Field menu)

When field help exists for this field, this command will display that help. Field help is written by 
the form designer and typically serves to explain the field contents in non-obvious cases.

Field help is presented in a simple dialog box. Either press the Enter key, or click on the OK 
button to continue filling out the form.

Shortcut
Toolbar:
 Keys: Ctrl + H



Context Help command

Use the Context-Help command to obtain help on a specific FillPower PRO function. When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark. Click somewhere in the FillPower PRO window, such as another Toolbar button, 
or pulldown menu. The Help topic will be shown for the item you click on, if it applies.

Shortcut
Toolbar:
Keys: Shift + F1



Horizontal Scroll bars

Horizontal Scroll bars are positioned at the bottom. Scroll bars are displayed at the right and 
bottom edges of the form window when the form exceeds the size of that window. The scroll 
boxes inside the scroll bars indicate your vertical and horizontal view of the form. You can use 
the mouse to bring other parts of the form into view.



An Inactive form does not have a highlighted title bar. Click on any visible part of the form to 
make it the active form. Select the Window pulldown menu for a list of open form file windows.



Contents command (Help menu)

Use this command to display the opening Help screen. From here you can select any of the 
main help topic categories, including both instructional and reference information. Help is 
displayed by another program called WINHELP, which is provided with Windows.

At any time while in help, you can click the [Contents] button to return to the Contents screen.

Add your own notes to the help file by using Help's Edit-Annotate command or the Annotate 
toolbar button. All annotations are saved in the Windows program subdirectory as filename 
[program].ANN. These annotations can only be modified and viewed during display of this help 
file. As a reminder, annotated topics will display a paper-clip icon to the left of the topic title.



Installation
The installation process is accomplished by running the INSTALL.EXE program present on disk 
1 of the distribution disks. INSTALL copies the program and its support files, this help file and 
various other infomation files. When system files already exist on your system that are newer 
than identically-named files on the FillPower PRO distribution disks, INSTALL will not overwrite 
the newer files. Installation and use of FillPower PRO must always follow the FillPower PRO 
License Agreement.

Here is a list of functional files that comprise the FillPower PRO product. This list may prove 
useful when troubleshooting any difficulties that may occur either during installation or when 
running the FillPower PRO program.

Program Files

These files belong in the FillPower PRO program directory since they are unique to FillPower 
PRO.

[program].exe
ezx1.dll
[program].hlp

System Support Files

These files are in general use in the industry, and should reside in the Windows System 
directory, typically c:\windows\system.

ctl3d.dll
mfcoleui.dll

OLE Version 2 System Files

These files implement the Microsoft Windows OLE Version 2 system. As above, they are in 
general use and should reside in the Windows System directory. The regedit.exe program, 
which is part of Windows, must be present on your system during installation, to allow proper 
configuration of OLE 2.

compobj.dll
ole2.dll
ole2conv.dll
ole2disp.dll
ole2nls.dll
ole2prox.dll
storage.dll
typelib.dll
ole2.reg
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NOTE: FillPower PRO™ is a subset of FormPower PRO™.
For more information, contact EZX Corporation at 713-280-9900    FAX:
713-280-0099.
                                Please ignore any obvious references to FormPower.

Special versions of FormPower/FillPower specifically tied to custom developed forms, 
are the “engines” that drive products like ExportPower™, PackageTrakker™, 
YourForms™, WinDD250™, WinSF171™, AnyPower™, MedPower™, 
ExpensePower™, etc.

Should you require a special “sub-published” edition of FillPower PRO customized for 
you and your special form or application, contact EZX at the address and numbers 
below.

Thank you for using FillPower PRO™ for Windows © 1994,96 by and from:    (All rights 
reserved.)

Call for Multi-user, LAN, Server, Site, Regional and Corporate licensing.

Ask about upgrade, competitive, and introductory pricing.

Also ask about custom design and “sub-publishing” services.

Specifications, pricing, etc. are subject to change without notice.

Copyright © 1994, 96 All rights reserved by:

EZX Corporation
“The Forms Automation Company”
403 E. NASA Rd., Suite 377
PO Box 58177    -    FIP96e
Webster (Houston), TX    77598-8177    USA

Technical Support:
Voice: +1-713-280-0080 (9:00am - 4:00pm    Central    USA    M - F)
EZ-Host! BBS: +1-713-280-8180 (E-mail; Support, etc. 24hrs. per day)
Internet: ezx@cris.com    or    EZXHOU@aol.com (E-mail)



AmericaOnLine: EZXHOU (E-mail)
CompuServe: 76350,3111 (E-mail)
World Wide Web: http://www.cris.com/~ezx or    http://home.aol.com/EZXHOU

For all other business and International:
Voice: +1-713-280-9900 (Questions, Comments, observations, & 

support.)
FAX: +1-713-280-0099 (Inbound FAXes; 24hrs per day.)

The following section describes FormPower PRO:

• Whether your business is small or large, you can easily and quickly Create, Fill-in (internally 
generated forms),    Fill-out (pre-printed forms), Save, Save-as, Revise, and-or Print all kinds of 
forms in minutes.

 •Create custom forms (lines, boxes, etc.) on screen and add fill-out fields, clip art, graphic 
images, signatures, scanned photographs, and even video movies (e.g..      .AVI) or sound clips 
(e.g..      .WAV) via Windows' OLE feature!

• You can save time and money by having your existing forms and logos scanned to graphic 
(e.g..      .BMP) image files. Adding filler "fields" creates your own filled-in forms. Its that "EZ"! 

• You can even fill-out pre-printed forms!

FormPower PRO™ for Windows is here!!!

FormPower PRO is GREAT FOR:
• Perfect form fill-out.
• Commercial Printers ... speeds form design, modification.
• In house publication departments ... Improve response time, ease update process, cut costs.
• Low cost forms development ... Develop and print all of your forms without outside help.
• Printing any quantity of custom forms on your laser printer on demand!

••• Great for basic desktop publishing too!

• FormPower PRO's focus is on forms design, production and fill-out. Unlike page document 
composition, the logical object oriented drawing tools are specifically tailored and optimized for 
forms design and manipulation. Its WYSIWYG (what-you-see-is-what-you-get) interactive 
screen is clear, intuitive and easy to use. Font size, typeface and printer options (including FAX 
transmission) are limited only by what is available under Microsoft Windows 3.1 for your system.
For truly flexible forms production, you can even print the filled-in data and the form at the same 
time or, fill-out to pre-printed forms.

CREATE TYPESET QUALITY FORMS IN HOUSE:
• You can design and modify your forms instantly. Creating a new form in house gives you 
complete control over the process. Feedback on how it looks is immediate. You can design 
forms for cut sheet and continuous forms applications. Print your new design on your laser 
printer, or for even higher resolution, send Postscript output to a phototypesetter. By retaining 
control of the forms design, you can lower the costs and turnaround time without sacrificing 



quality. By printing your own on demand forms on your laser printer, you can economize by 
reducing stock of pre-printed forms. Another benefit is the reduction of obsolescence of forms.

• You can easily customize any of the 100+ included form templates (may be optional with some
packaging) to create any new form you desire.

DESIGN FORMS QUICKLY and EASILY:
• Using the display screen and mouse, you can perform fully interactive forms composition by 
creating and manipulating various "objects".
• WYSIWYG means that the screen looks like the final printed from, showing typefaces, font 
sizes, lines, rectangles, rounded rectangles, ellipses, circles, shading, logos, etc. Size any 
object for creative impact. 
• Text can be automatically word-wrapped, justified (left, center, right), fonted, colored, etc. in 
any text or fill-out field. 

INCORPORATE GRAPHICS AND PATTERNS:
• Logos, signatures and scanned images can be added to your form. Tools are provided to crop,
scale, copy, delete and move images and objects like text, lines, fill-out fields, etc..

Other Form Design and Fill-out Features include:
• Extensive on-line help and manual.
• On-screen grid (user adjustable; does not print) and snap-to-grid allow very quick and precise 
positioning of all objects and fields.
• Fill-out master or modify completed forms. No need to retype redundant information.
• Open multiple forms at once for quick reference or cut-and-paste.
• Multiple form views can be full window, window cascade, tile view, or reduced to icons.
• Six different working view magnifications (2 are user adjustable) 25% to 300% are available for
even the most intricate work.
• Precise continuous coordinate display for accurate positioning.
• Tool bar and status line control allow you to customize appearance and operation of the 
program.
• Copy, cut, and paste objects between multiple FormPower PRO forms.
• Define page sizes, margins, layouts, orientation.
• Draw lines, boxes, shapes, fill patterns of many types, change orientation and color.
• 26 drawing tools are provided form design. There are five pen line styles, ten thicknesses and 
eight brush patterns.
• Other drawing tools include rectangle, round rectangle, and ellipse which can be melded with 
any of the brush patterns.
• Fill-out fields can be placed anywhere on the form, and in fill-out mode, the master part (or 
background) of the form cannot be modified so as to assure perfectly filled out forms every time.
• Print preview any form before committing to hard copy.
• Print to any Windows supported device, even directly to your FAX-modem (third party drivers 
required) for immediate transmission of your form.
• Use any Windows TrueType font including Bar Codes, and special characters of almost any 
size like Wingdings and Symbols.
• Quickly bold, underline, italicize, strike-through, etc. any character or group of characters.
• Objects, including graphics, pictures, sound clips, video clips, etc. can be inserted quickly and 
easily via Windows' OLE (Object Linking and Embedding v1.0 & 2.0) feature from almost any 
other Windows program.
• Edited .BMP files (via WinPaintbrush and many other programs) can be linked to any FillPower



PRO master form.
• You can even paste text from your trusty ol' DOS programs via Windows' clipboard.

• New features in Release 95h/1.30 include:
• Support for international measurements and paper sizes.
    Window's international settings are monitored and the appropriate defaults 
    are used. (ISO paper sizes and metric mesurements, for instance)
• Unlimited character size for text objects. (Old limit was 256 characters.)
• Improved OLE functionality.
• Date and Time feed.
• Multiple copy printing.
• Graphics placement/sizing is faster via use of screen tokens.
• Screen updates are faster too.

Call for Multi-user, LAN, Server, Site, Regional and Corporate licensing.

Ask about upgrade, competitive, and introductory pricing.

Also ask about custom design and “sub-publishing” services.

Special versions of FormPower/FillPower specifically tied to custom developed forms, are the 
“engines” that drive products like ExportPower™, PackagrTrakker™, YourForms™, 
WinDD250™, WinSF171™, AnyPower™, MedPower™, ExpensePower™, etc. Call for details.

Should you require a special “sub-published” edition of FormPower/FillPower customized for 
you and your special form or application, contact EZX at the address and numbers below. 
Developers and VARs only, please.

Specifications, pricing, etc. are subject to change without notice.

Copyright © 1994, 96 All rights reserved by:

EZX Corporation
“The Forms Automation Comapny”
403 E. NASA Rd., Suite 377
PO Box 58177    -    FIP96e
Webster (Houston), TX    77598-8177    USA

• Credit Card Orders (Visa, MasterCard, Discover, American Express) at:
    Voice Order Desk: 1.800.800.2H4O6T8 (toll free in the USA; support/service calls will 
incur a service charge))
    FAX Order Desk: 1.800.F3A2X9.2H4O6T8 (toll free in the USA; All other 
correspondence, etc. will be ignored.)

Technical Support:
Voice: +1-713-280-0080 (9:00am - 4:00pm    Central    USA    M - F)
EZ-Host! BBS: +1-713-280-8180 (E-mail; Support, etc. 24hrs. per day)
Internet: ezx@cris.com    or    EZXHOU@aol.com (E-mail)
AmericaOnLine: EZXHOU (E-mail)



CompuServe: 76350,3111 (E-mail)
World Wide Web: http://www.cris.com/~ezx or    http://home.aol.com/EZXHOU

For all other business and International:
Voice: +1-713-280-9900 (Questions, Comments, observations, & 

support.)
FAX: +1-713-280-0099 (Inbound FAXes; 24hrs per day.)

Shipping & Insurance:
$7    USA-48 for ground (7-10 days) shipping. $2 for each additional item.
$12 USA-48 for 2nd business day shipping. $2 for each additional item.
$24 USA-48 for Next Business day shipping. $4 for each additional item.
$12 AK-HI-PR-VI-GU-AS; Canada (all provinces). $3 for each additional item.
$19 Elsewhere. $4 for each additional item.
• You can request whatever shipping you wish, such as your own FedEx number, for 
actual cost plus $7 handling charge per order.



Keyboard Commands
Text and Field Edit Objects

Arrow keys Cursor movement
Home Beginning of line
End End of line
Ctrl + Home Beginning of text
Ctrl + End End of text
Ctrl + Left Previous word
Ctrl + Right Next word
Shift Add to any above key to select text
Insert Toggle insert / overstrike mode
Delete Delete a character to the right
Enter Terminate text entry
Ctrl + Enter Force new line
Alt + Backspace
or Ctrl + Z

Undo

Fillout Mode
Arrow keys Cursor movement
Tab Next field (Options-Preferences-Tab between 

fields toggled ON)
Shift + Tab Previous field (Options-Preferences-Tab between

fields toggled ON)
Enter Next field
Shift + Enter Previous field

Form / Window Movement
PageUp Scroll up page
PageDown Scroll down page
Ctrl + PageUp Scroll left page
Ctrl + PageDown Scroll right page
Ctrl + Home To First field
Ctrl + End To Last field
Ctrl + Up Scroll up line
Ctrl + Down Scroll down line

Menu Hot Keys
Ctrl + Key combinations:

Ctrl + O File - Open
Ctrl + F File - Fillout
Ctrl + S File - Save
Ctrl + P File - Print
Ctrl + X Edit - Cut
Ctrl + C Edit - Copy
Ctrl + V Edit - Paste
Ctrl + Z Edit - Undo Delete
Ctrl + T Edit - Text Feed - Time
Ctrl + D Edit - Text Feed - Date



Ctrl + R Refresh Screen to eliminate screen movement 
artifacts.

Ctrl + F4 Form Control - Close
Ctrl + F6 Form Control - Next

Alt + Key combinations:

Alt + F4 Program Control - Close
Alt + Backspace Edit - Undo Delete



FillPower PRO License Agreement
NOTE: The following agreement is meant for a single-user / single-machine use of
FillPower PRO.
• If you have multi-machine, network, site or Corporate licensing needs, contact 
EZX's sales department at the numbers below.

The FillPower PRO program and all of its components are protected by United States Copyright 
Law and International Treaty provisions. All worldwide rights are reserved.

Copyright ©1994, 96 All Rights Reserved
Distributed by:      EZX Corporation
“The Forms Automation Company”

P. O. Box 58177, Webster, TX 77598-8177 USA
Phones: Voice:1.713.280•9900      FAX:1.713.280•0099

BBS:1.713.280•8180      Tech:1.713.280•0080

LICENSE/REGISTRATION STATEMENT (This does not apply to TestDrive versions which are 
licensed for 15 day trial use.): The FillPower PRO (PROGRAM) is protected by United States 
Copyright Law and International Treaty provisions. All rights are reserved. You may use this 
program as indicated in the serial number, license/registration agreement, and purchase receipt,
on a single machine. (Your hard copy license/registration card may indicate authorization for 
multiple-machines or a network for the stated amount of users. If this is the case, that card 
supercedes this license statement with regard to a single user.). EZX Corp. hereby grants a 
“book” license to the original individual user (even if purchased by a company or other 
organization) of this copy of FillPower PRO. You may use the program on your computer and 
make one backup copy, as long as there is no possibility of use or residence on more than one 
machine at any time. Just like two people cannot read the same book in different locations at 
the same time. Use of any kind by a single user version on a Local Area network is prohibited. 
Every copy of FillPower PRO has a unique serial number embedded within it, for traceability. 
You may not make, sell, or give copies of this program and documentation to anyone. No 
exceptions. EZX Corp. makes no warranty of any kind, expressed or implied, including (without 
limitation), any warranties of merchantability and/or fitness for a particular purpose. EZX Corp. 
shall not be liable for any damages, whether direct, indirect, special or consequential arising 
from a failure of this program to operate in the manner desired by the user. EZX Corp. shall not 
be liable for any damage to data or property which may be caused directly or indirectly by use of
the program. EZX Corp. makes no claims, offers no warranties, and assumes no responsibility 
for any sort of damage (mental or physical) resulting from the apparent or actual use of our 
products. Any text files, printer control files, or forms provided with this product are not 
guaranteed as to merchantability or fitness for its ultimate use. User accepts all responsibility for
use and may not resell any supplied text file, printer control file or form. A person, business, 
corporation, government organization or any other entity, to do so is strictly forbidden from using
unregistered copies of this program and, is a violation of this license agreement. FillPower PRO 
may not be distributed in conjunction with any other product, without written permission from 
EZX Corp. The License Agreement and statement shall be construed, interpreted and governed 
by the laws of the United States of America and the state of Texas.

All pricing, terms and conditions are subject to change without notice. Some of the terms used 
within this document are trademarks of the following firms: International Business Machines, 



Sony, Microsoft, Lotus Development Corp., Intel Corporation. Etch-a-Sketch is a registered 
trademark of Ohio Art.

FormPower, FillPower, HotFormz, HotFiller, EZ-Forms Gold, EZ-Forms, EZ-Forms Lite, 
SuperForms, SuperForms PRO, PF, EZ-Forms Plus, EZ-Forms eXecutive, EZ-Forms 
DataBase, EZ-InFORMa dB, EZX-Word, EZ-Spreadsheet, EZ-DiskCopy PRO, etc. are 
trademarks of EZX Corporation.      ©1994, 96 EZX.



FillPower PRO Logo and Icon is Copyright © 1994,96 and Trademark ™ by EZX 
Corporation.

Thank you for using FillPower PRO™ for Windows © 1994,96 by and from:    (All 
rights reserved.)

EZX Corporation
“The Forms Automation Company”
403 E. NASA Rd., Suite 377
PO Box 58177    -    FIP96e
Webster (Houston), TX    77598-8177    USA

• Credit Card Orders (Visa, MasterCard, Discover, American Express) at:
    Voice Order Desk: 1.800.800.2H4O6T8 (toll free in the USA; service/support calls will 
incur a service charge)
    FAX Order Desk: 1.800.F3A2X9.2H4O6T8 (toll free in the USA; All other 
correspondence, etc. will be ignored.)

Technical Support:
Voice: +1-713-280-0080 (9:00am - 4:00pm    Central    USA    M - F)
EZ-Host! BBS: +1-713-280-8180 (E-mail; Support, etc. 24hrs. per day)
Internet: ezx@cris.com    or    EZXHOU@aol.com (E-mail)
AmericaOnLine: EZXHOU (E-mail)
CompuServe: 76350,3111 (E-mail)
World Wide Web: http://www.cris.com/~ezx or    http://home.aol.com/EZXHOU

For all other business and International:
Voice: +1-713-280-9900 (Questions, Comments, observations, & 

support.)
FAX: +1-713-280-0099 (Inbound FAXes; 24hrs per day.)

Special versions of FormPower/FillPower specifically tied to custom developed forms, 
are the “engines” that drive products like ExportPower™, PackageTrakker™, 
YourForms PRO™, WinDD250™, WinSF171™, AnyPower™, MedPower™, 
ExpensePower™, etc. Call for details.

Should you require a special “sub-published” edition of FormPower/FillPower customized for 
you and your special form or application, contact EZX at the address and numbers above. 
Developers and VARs only, please.



Maximize button

The Maximize button for a form window will expand the window to full FillPower PRO client 
window size and set the currently active window display to be the default until changed.

Shortcut
Mouse:

Click on the maximize icon  on the title bar, or 
double-click the title bar.



Maximize button

Use this button to enlarge the active window to fill available space. A form window Maximize 
button will expand its window to the size of the FillPower PRO main window, and set it to be the 
active window. The main window Maximize button will expand the FillPower PRO main window 
to fill the entire screen.

Shortcut
Mouse:

Click the maximize icon  on the title bar, or double-click the title bar.
Keys: Ctrl + F10 enlarges active form window.



Minimize button

The Minimize button of a form window will iconize the active window and display the icon within 
the FillPower PRO client area, usually at the bottom.

Shortcut
Mouse:

Click the minimize icon  on the title bar.



Minimize button

In the main window, use this command to reduce the FillPower PRO window to an icon. The 
Minimize button of a form window will iconize the active form window and display the icon within
the main window (client area).

Shortcut

Mouse: Click the minimize icon  on the title bar.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog 
box with the arrow keys.

Note:    This command is unavailable if you maximize the window.



Next Window command (Form Control menu)

Use this command to switch to the next open form window. FillPower PRO determines which 
window is next according to the order in which you opened (or last edited) the windows.

Shortcut
Keys: Ctrl + F6



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Open command (File menu)

Use the Open command to open an existing form in a new window. You can open multiple forms
at once. Use the Window menu to switch among the multiple open forms. See Window 1, 2, ... 
command.

Choose Fillout to open a form containing fields for data entry.

Select the name of the form you want to open in the Open dialog box.

Note: The single user, non-network version of FillPower PRO will not read-from or save-to a 
network drive.

Shortcut
Toolbar:

Keys: Ctrl + O



Overview
This Overview is meant to help you understand the FillPower PRO user interface, including 
menus, toolbars, icons, etc.

Fillout Mode Overview
A master form is filled out in FillPower PRO, which creates a filled-out form. The filled-out form 
file extension is .fof. None of the Design Mode functionality is available during fillout, thereby 
avoiding problems with inadvertent modification of headings, borders, etc.



Overview command (Help menu)

Use this command to display the Overview Help screen. The Overview is meant to help you 
understand the FillPower PRO use interface, including menus, toolbars, icons, etc.

At anytime during Help, you can click the [ Contents ] button to return to the opening screen.

Add your own notes to the help file by using Help's Edit Annotate command or the Annotate 
toolbar button. All annotations are saved in the Windows program subdirectory as filename 
[program].ANN. These annotations can only be modified and viewed during display of this help 
file. As a reminder, annotated topics will display a paper-clip icon to the left of the topic title.



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents into the form. This command is 
unavailable if the clipboard is empty.

When pasting an object, the new object is placed at a position similar to the original object. The 
new object is also automatically selected.

The Cut and Copy commands can place text or objects into the clipboard. The Paste command 
then places a copy of the current clipboard contents into the form, even when the clipboard 
contains text or objects that were copied or cut from another form. Text and OLE objects can be 
copied from other applications.

Shortcut
Toolbar:
Keys: Ctrl + V



Pick command (Field menu)

When a pick list exists for the current field, this command will display that pick list, allowing a 
chosen item to be quickly placed into the field. A pick list is created by the form designer in order
to make form fillout quicker and more accurate. It is usually best to choose from an existing list 
rather than type it in, since errors can result even in the simplest cases.

The pick list is presented in a dialog box, where a selection can be made with the keyboard or 
via mouse clicks. To use the keyboard, select the item with the up/down arrow keys then press 
Enter. With the mouse, either double-click on the item, or single-click on the item and then click 
on the OK button.

Shortcut
Toolbar:
 Keys: Ctrl + L



Pick List

Choose one of the items in this list for entry into the current field. You can select the item using 
a mouse click or arrow keys, or you can directly double-click on your selection.

The list presented here was created by the form designer to help during fillout. Whenever a pick 
list is present it is best to use it, as this leads to more consistent and accurate form fillout.



Preferences command (Options menu)

The settings assigned in the Options-Preferences dialog box are used to set defaults for 
program operations. These settings determine the way master forms and filled out forms 
function as you use them.

This is also where you can assign two custom view scale (25-300%) settings available in the 
View menu.

All options are saved into the .ini file with the Options-Save Settings command.



Preferences - All Tab

Sets defaults for various program operating parameters. You may temporarily change settings 
during the current session without saving them (Options-Save Settings). In this case, the 
original settings will be used next time you start FillPower PRO.

Custom Sizes:
The display scale you indicate here will be listed in the View pulldown menu.

Note:  Two of the view settings selectable from the View pulldown menu are user definable. 
Default settings for these custom view scales are defined by selecting Options-Preferences.

Four standard viewing scales are selectable from the pulldown menu and three of the most 
commonly used are available on the Toolbar. Two additional custom scales are user definable in
the Options-Preferences dialog box and are displayed in the View pulldown menu.

The two custom scales can be adjusted to settings you prefer. In the Options-Preferences dialog
box there are two fill in areas where you define the view settings. Accepted values are 25% 
through 300%.

Smooth Display:
The Smooth Display view option affects aesthetics only. It allows user control of a tradeoff 
between display flicker and speed. When off, the FillPower PRO display is faster, but objects 
can flicker as they are moved. When on, the display is slower, but no flicker occurs. The Smooth
Display term represents a flicker-free display.

Personal preference and program usage will dicate this setting. Turning off Smooth Display 
during form design allows faster object movement. During fillout, the difference is less 
noticeable and less beneficial.

See Also

Main Tab
Fillout Tab
Master Tab



Preferences - Fillout Tab

Sets defaults for various program operating parameters. You may temporarily change settings 
during the current session without saving them (Options-Save Settings). In this case, the 
original settings will be used next time you start FillPower PRO.

Display coordinates:
The position of the Pointing Device (mouse) cursor will be displayed on the Status bar while in 
fill out mode.

Tab between fields:
When ON, the Tab key will move data entry to the next field, and the Shift+Tab key will move 
data entry to the previous field.
Shift+Enter is always available to move data entry to the previous field. Enter always moves to 
the next field. For multi-line fields, only from the bottom line will Enter move to the next field.

Toolbar:
Toggle On or Off the toolbar display that appears in the active form window. When entering data
into a filled-out form (.fof extension) the Fillout Mode toolbar is normally displayed.

See Also

Main Tab
All Tab
Master Tab



Preferences - Main Tab

Sets defaults for various program operating parameters. You may temporarily change settings 
during the current session without saving them (Options-Save Settings). In this case, the 
original settings will be used next time you start FillPower PRO.

Toolbar:
Toggle On or Off the main Program toolbar display that appears just below the pull down menu. 
This toolbar remains available for both form design and fillout operations.

Status Bar:
Toggle On or Off the Status Bar displayed at the bottom of the program's window. Information 
such as instant help lines, mouse coordinates, type of active form and keyboard toggles are 
displayed.

See Also

All Tab
Fillout Tab
Master Tab



Preferences - Master Tab

Sets defaults for various program operating parameters. You may temporarily change settings 
during the current session without saving them (Options-Save Settings). In this case, the 
original settings will be used next time you start FillPower PRO.

Display coordinates:
The position of the Mouse will be displayed on the Status bar while in design mode.

Remember drawing tool:
When OFF, once an object is placed after selecting a drawing tool, the tool is deselected and 
select mode will automatically activate. This is indicated by the mouse cursor changing from a 
crosshair to an arrow. However, this automatic drawing tool deselection can be cumbersome 
when placing multiple objects with the same tool.
When ON, the drawing tool is not automatically deselected, so another object of the same type 
can be immediately placed.

View Fields:
When OFF, fields are shown in design mode the same way they will be shown in fillout mode. 
This means that borderless fields will be completely invisible unless selected. In fillout mode this
is acceptable since the user will be using Enter or Tab to move to the next field. In design mode,
fields aren't always apparent, but they also will not clutter the master form.
When ON, fields are indicated with a black border wrapped around the field's name. This is 
probably most desirable when placing, moving and resizing fields.

Toolbar:
Toggle On or Off the toolbar display that appears in the active form window. When creating or 
modifying a master form (.frm extension) the Design Mode toolbar is normally displayed.

See Also

Main Tab
All Tab
Fillout Tab



Print command (File menu)

Use this command to print a form. Presents a Print dialog box, where you may specify number 
of copies, destination printer, and other printer setup options.

Note: Make sure your printer landscape or portrait setting corresponds to the size and type of 
your form.

Shortcut
Toolbar:
Keys: Ctrl + P



Print Dialog

The following options allow you to specify how and where the form is printed.

Printer:
This is the active printer and printer connection. Choose the Setup option to change the printer 
and printer connection.

Print Range: (Unsupported)
Specify the pages you want to print:
All        Prints the entire form.
Selection        Prints the currently selected text.
Pages        Prints the range of pages you specify in the From and To boxes.

Print Quality:
Select the quality of the printing. Generally, lower quality printing takes less time to print.
Available choices are:
High
Medium
Low

Copies:
Specify the number of copies you want to print for the above page range.

Collate Copies:
Prints copies in page number order, instead of separated multiple copies of each page.

Setup button
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Progress Dialog
A small dialog box showing progress is displayed while FillPower PRO is sending output to the 
printer. To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to preview how the active form will look on paper. This can minimize the 
amount of paper used to print out intermediate copies during Master Form design.

When you choose this command, the main window will be replaced with a print preview window.
The Print Preview toolbar offers you selections that change the view; move back and forth 
through the form; zoom in and out of pages; and can even initiate a print job.

Shortcut
Toolbar:



Print Preview Toolbar

Access the Print dialog box to start a print job.

Unsupported. Preview the next page.

Unsupported. Preview the previous page.

Unsupported. Preview one or two pages at a 
time.

Take a closer look at the page. (Make it bigger on
screen. Less of the page appears on screen with 
higher resolution.)

Take a larger look at the page. (More of the page 
appears on screen with lower resolution.)

Return from Print Preview to the main window.



Print Progress Dialog

The Printing dialog box is shown while FillPower PRO is sending output to the printer. The copy 
count and/or page number indicates the printing progress.
To abort printing, choose Cancel.



Print Setup command (File menu)

Use this command to select a printer and a printer connection. Presents a Print Setup dialog 
box where you specify the printer, its connection, and page orientation.



Print Setup Dialog

The following options allow you to select the destination printer and its connection.

Printer
Default Printer:
Choose the Default Printer as defined in the Windows Control Panel setting.
Specific Printer:
Choose a Specific Printer from one of the currently installed printers shown in the box. You may 
install other printers and configure ports (LPT1:, etc.) using the Windows Control Panel.

Orientation
Portrait:
This is normal orientation, where text is printed in the natural page orientation for the printer. For
example, an 8.5" wide by 11" high form would be printed in Portrait orientation on a LaserJet 
printer.
Landscape:
This orientation prints text 'sideways' on a page. For example, an 11" wide by 8.5" high form 
would be printed in Landscape orientation on a LaserJet printer.

Paper
Size:
Select the size of paper that the form is to be printed on.
Source:
Some printers offer multiple trays for different paper sources. Specify the tray here.

Options button
Displays a dialog box where you can make additional choices about printing, specific to the type
of printer you have selected. This dialog is presented by the selected printer's driver, which has 
full control over any printer-specific options. Printer drivers are provided by Microsoft and/or the 
printer manufacturer.

Network button
If you are connected to a network file server or workgroup, this button will activate your available
network services.
Note:    The single user version of FillPower PRO does not support network drive or services 
access, even though the Network button may be active.



Process Dialog

During fillout, field validations and calculations are carried out as appropriate, whenever the 
cursor moves into or out of a field. Since FillPower PRO provides various methods for changing 
field order and even bypassing fields, validations and calculations are repeated for all fields just 
prior to committing a form to use, such as when saving or printing it. However, there are 
situations where this repetition may not be appropriate, such as when saving a blank form.

This dialog allows for complete control over when revalidation and recalculation occur for all 
fields. When none of the fields make use of one or the other, that option is disabled. When the 
automatic processing is useful, or even when you're not sure, simply leave the options turned 
on. Otherwise, depending on the situation, you can turn revalidation or recalculation off.

At any time, use the Field Recalc All command to revalidate and recalculate all fields. This is 
identical to the processing described above. Fields are evaluated in normal left-right, top-down 
order.



The main window Title bar displays the FillPower PRO program name and the name of the 
active open form window.

The Form window Title bar indicates the name of the form. If the form is active, the title bar is 
highlighted.



Are you sure you want to clear the entire form?
Design mode

All objects in the form will be deleted.

Fillout mode

All fields will be cleared, and the master form will remain intact. When modifying an existing 
filled-out form, fields are only cleared in memory, leaving the file unchanged.

To prepare a new form to fill out, use the Edit-Fillout-New command.



Save option settings?
If you have modified any of the default settings in the Options menu, this message is a reminder
at program exit to save those changes. All defaults are saved in the [program].INI file in your 
Windows subdirectory.



Refresh command (View menu)

Use Refresh to update the screen at any time. This may be necessary when artifacts are 
caused by the Windows GUI or some video drivers during busy or complex editing sessions.

Shortcut
Keys: Ctrl + R



This number indicates the number of days between automatic reminders of probable FillPower 
PRO upgrades. The reminder message will reappear every 7-180 days (you select) in order to 
remind you that it may be time to get the latest version of FillPower PRO. This is not meant to 
nag you, but to gently remind you that we may have bigger and better things in the works.



Restore command (Control menu)

Use this command to return the active window to its previous size and position, before you 
selected the Maximize or Minimize command.



Save command (File menu)

Use this command to save the active form to its current name and directory. When you save a 
form for the first time, FillPower PRO displays the Save As dialog box so you can name your 
form. If you want to change the name and directory of an existing form before you save it, 
choose the Save As command. This command and its corresponding toolbar button will be 
greyed-out until the form has been modified.

Shortcut
Toolbar:
Keys: Ctrl + S



Save All command (File menu)

This command is used when there are two or more form windows open, one or more of which 
have been modified. Saves all open form files so you do not have to step through the save 
procedure for each and every one of them.



Save As command (File menu)

Use this command to save and name or rename the active form. FillPower PRO displays the 
Save As dialog box so you can name your form.

To save a form with its existing name and directory, use the Save command.

Note: The single user, non-network version of FillPower PRO will not read-from or save-to a 
network drive.



File Save As Dialog

The following options allow you to specify the name and location of the file you're about to save:

File Name:
Type a new filename to save a form with a different name. A filename can contain up to eight 
characters followed by a period and then an extension of up to three characters. FillPower PRO 
adds the extension. You specify the file name in the Save File As Type box. Notice that the file 
listing is shaded to help prevent using a file name that is already used. This area of the dialog 
box shows a shaded listing of files in the current subdirectory. The listing may help in naming 
the new file if you've forgotten the filenames already used. You can indicate the type of files you 
want listed by clicking on the arrow in the section just below.

Directories:
This section indicates the current subdirectory. Use the section below to change to a different 
subdirectory. Change subdirectories by using the scroll bar or by double-clicking on a directory 
name. If a directory is not shown, it may be located as a subdirectory below the one just above 
the current subdirectory. Try double-clicking on a directory name that is one or two levels above 
the current subdirectory.

Save File as Type:
Click on the arrow to change the type of files listed in the section just above.
Available choices are:
Master Forms. (*.frm)
All Files (*.*)

Drives:
Click on the arrow to search for files on a different drive.

Network button
If you are connected to a network file server or workgroup, this button will activate your available
network services.
Note:    The single user version of FillPower PRO does not support network drive or services 
access even though the Network button may be active.



Save Settings (Options menu)

Your fine tuning of the Defaults and Preferences settings will remain effective only during the 
current session. If you want them to apply to future sessions, they must be saved. Temporary 
adjustments for the current FillPower PRO session may be made to the options settings for 
repetitive or similar tasks without the need to make those settings permanent. Individual objects 
can be modified using the Form pulldown menu or the object popup menu. You must decide 
whether or not you will need the new adjustments after you have ended this session.



Fixed Views (View menu)

View scales allow for "zoom" in or out of any part of a form. "Scaling" or "zoom" is very similar to
how a zoom lens works on a camera. Zoom in and see it larger and in more detail, but see less 
of the form. Zoom out and see more of the form at a time, but see it smaller and in less detail. 
Depending on your screen resolution, a different scaling will be needed in order to view the 
entire form. If none of the standard scales match your needs, there are two user-definable 
scales. Print preview also allows for zooming in and out, but design and fillout features are 
unavailable there.

Four standard viewing scales are selectable from the View menu and three of the most common
ones are available on the Toolbar. Two additional custom scales are user-definable in the 
Options-Preferences dialog box and are displayed only in the View menu.

Shortcut
Toolbar:

Custom Views (View menu)

The two custom views can be adjusted to your preference. In the Options-Preferences dialog 
box there are two fields where you define the view scale settings. Acceptable values are 25% 
through 300%.



Send Mail (File menu)

Send a message via the resident email system, and sends the current form as an attachment. 
This is the same as if you were to send a message using your email program directly.

This menu item will not appear unless you have an email system that supports the Microsoft 
MAPI standard.



Size command (Control menu)

Click on the upper left corner (control tab) of the form window and select size.

Use this command to display a four-headed arrow so you can size the active window with the 
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the 

pointer to the border you want to move.
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the 

window.



Window Size

Size command (Control menu)

Use this command to display a four-headed arrow so you can size the active 
window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the 
pointer to the border you want to move.
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable when the window is maximized.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Status Bar

The status bar is displayed at the bottom of the FillPower PRO window. To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar (also know as micro-Help) describes menu items as you use the 
arrow keys to navigate through menus.

This area similarly shows “fly-by” messages that describe the toolbar buttons as the cursor 
passes over them.

Further to the right, two numeric values are displayed, representing the horizontal and vertical 
mouse position on the form relative to the upper-left corner. 

Another indicator will display "Master", or "Fillout" depending on the function mode you are in.

The far right area of the status bar indicates which of the following keys are set (check your 
keyboard for a light or other indication):

CAP The Caps Lock key is set.
NUM The NUM lock key is set.



Switch To command (Application Control menu)

Use this command to display a list of all open applications. Use this "Task List" to switch to or 
close an application on the list.

Shortcut
Keys: Ctrl + Esc

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar. This option does not
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap. This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Test OK. The expression has a Logical type result.
Design mode

When testing a validate expression during form design, this message confirms that the 
expression is valid for its intended purpose.

To pass validation during fillout, the expression must evaluate to TRUE.



Test OK. The expression result is of type: ??.
Design mode

When testing a calculation during form design, this message confirms that the result 
type of the expression matches the type of the field.



"TestDrive" refers to a fully functional version of FillPower PRO that is meant for evaluation of 
same, much like you test drive an automobile before you purchase it. Also, just like a test drive, 
the salesman usually comes along. So you may have to put up with occasional “commercials” 
asking you to purchase (a.k.a. regi$ter) the program.

The TestDrive edition of FillPower PRO is functionally identical to the full or registered version. 
However, only two forms may be opened simultaneously.

Regi$tering removes all TestDrive screens. Please feel free to “share” TestDrive editions ONLY 
of FillPower PRO with your associates.

Please help us keep the cost of software low by NOT SHARING registered versions of FillPower
PRO with anyone within the limits of the license granted to legitimate purchasers by EZX.



For internal use only.



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Text Feed-Time (Edit menu) & Time (Field menu)

Quickly insert system Time into a field during data entry.using Ctrl + T. Any text that may 
already be in the field will be overwritten. You will not be able to auto insert into the middle of a 
sentence or phrase.

The format for Auto Text Feed is controlled by the Windows Control Panel International settings.

Shortcut
Toolbar:
 Keys: Ctrl + T



Main Toolbar

The main toolbar is displayed across the top of the FillPower PRO main window, below the 
menu bar. It provides quick mouse access to the commands used most often. To hide or display
the Main Toolbar, select the Toolbar option from the Options Preferences Main dialog tab.

In addition to the main toolbar, there is a forms window toolbars.

Toolbar - Fillout Mode
Displayed across the top of the active form's window while in fillout mode only. It provides quick 
mouse access to various commands that are unique to fillout mode.

Click on any toolbar button for further explanation.

Toolbar:    Pulldown Menu: Hot Key:
Action:

File - Open Ctrl + O
Open an existing form. FillPower PRO displays the Open dialog box, in which you can locate 
and open the desired file.

File - Save Ctrl + S
Save the active form or template with its current name. If you have not named the form, 
FillPower PRO displays the Save As dialog box.

Edit - Cut Ctrl + X
Selected objects or text can be removed by using the Cut toolbar button or the Edit-Cut 
command. The object or text is also placed in temporary storage on the Windows clipboard.

Edit - Copy Ctrl + C
Make a duplicate copy of the selection to the clipboard. Selected objects can be duplicated by 
using the Copy toolbar button or the Edit-Copy command.

Edit - Paste Ctrl + V
Insert the contents of the clipboard into the active form. For text, position the cursor to the 
desired place before pasting. Objects and text can be pasted by using the Paste toolbar button 
or the Edit-Paste command.

File - Print Preview Preview the active form on screen. Click on this toolbar button or 
select the File-Print Preview command.

File - Print Ctrl + P
Presents a Print dialog box, where you may specify number of copies, destination printer, and 
other printer setup options.



Help - Contents F1
Displays the FillPower PRO Help Contents screen.

Context Help Shift + F1
Use the Context Help command to obtain help on a specific FillPower PRO command, icon or 
screen area.

View - Scale Three of the six most commonly used view choices.



Design Mode Toolbar
Displayed across the top of the active form's window while in design mode only. It provides 
quick mouse access to various commands that are unique to design mode. To hide or display 
this toolbar, select the Toolbar option from the Options Preferences Master dialog tab.

Click on any toolbar button for further explanation.

Toolbar:    Pulldown Menu: Hot Key:
Action:

Draw - Line Line Drawing tool.

Draw - Rectangle Rectangle Drawing tool.

Draw - RoundRect Rounded Rectangle Drawing tool.

Draw - Ellipse Ellipse Drawing tool.

Draw - Text Text Drawing tool.

Draw - Field Field Drawing tool.



Fillout Mode Toolbar

Displayed across the top of the active form's window while in fillout mode only. It provides quick 
mouse access to various commands that are unique to fillout mode. To hide or display this 
toolbar, select the Toolbar option from the Options Preferences Fillout dialog tab.

Click on any toolbar button for further explanation.

Toolbar:    Pulldown Menu: Hot Key:
Action:

Field - Help Ctrl + H
Display a field-specific Help screen created by the form designer.

Field - Pick Ctrl + P
Display field-specific Pick list created by the form designer.

Field - Date Ctrl + D
Place the current date into the field.

Field - Time Ctrl + T
Place the current time into the field.

Field - Calculate Recalculate the formula in the current field.

Field - Validate Validate this field's contents based on the form designer's criteria.



Troubleshooting
General Protection Fault Errors

Can't find auto number, pick list or field help file



Troubleshooting: Can't find auto number, pick list or field 
help file
Problem: During fillout or design mode field setup test, FillPower PRO can't find auto number, 
pick list or field help files.

Solution: When FillPower PRO needs an auto number, pick list or field help file, where it looks 
for it depends on whether the form designer specified the full path to it or just the file name. 
There are tradeoffs to both situations, so the final solution depends on your particular needs.

When a file is specified by file name only, FillPower PRO looks in the same directory as the form
file itself. This can create problems when copying or saving filled-out forms into directories other
than the original. In this case, make sure to copy all associated files with the form. This method 
is desirable when form files tend to move between different systems or are shared on a LAN.

When a file is specified by it's full path name, FillPower PRO always uses that path when 
looking for the file. This can resolve the situation of saving fillout forms into directories other 
than the original of the same system. It may not help when moving forms to different computers 
or systems. Use this method only for form files that are not generally moved around between 
directories and systems.



Troubleshooting: General Protection Fault Errors
Problem: You receive an error message indicating that FillPower PRO has caused a General 
Protection Fault (GPF) Windows system error.

Solution: GPFs are very tricky things. Usually they happen when resources are low (has 
nothing to do with memory installed), or possibly some other unstable program is running or has
been shut down and it has left open some files or other system resources.

Your CONFIG.SYS file should contain the following statements:
      FILES=80
      stacks=16,512
      SHELL=C:\DOS\COMMAND.COM C:\DOS\ /e:1024 /p    (do not change if already set.)
      DOS=HIGH    or DOS=UMB      (do not change if already set.)

The 'SHELL=' path may need to be changed for your system.

It is possible that GPFs could be caused by running out of room on the system stack heap. 
Increasing the files count and stack resources will probably solve the failure. See the DOS 
docuementation for the STACK command for more information. Try running FillPower PRO as 
the only open program in Windows. Check the Startup group for any programs that load 
automatically.



Undo Delete Command (Edit menu)

Use this command to reverse the last delete, if possible.

Shortcut
Keys: Ctrl + Z      or

Alt + Backspace



Using Help command (Help menu)

Use this command for detailed instructions about how to use the Windows Help program.



Validate command (Field menu)

When a validation exists for the current field, this command will process it. A field validation is 
created by the form designer in order to make form fillout easier and more accurate. Unless 
"override on error' was selected by the designer, fillout cannot continue to the next field until 
valid data is placed into the field.

When a field does contain invalid data, an error message displays. This error message could 
have been written by the designer, but if it wasn't it defaults to a generic one. Since validations 
are written as expressions like calculation are, expression errors can also occur. Any errors will 
result in an error message displaying the expression and the field name of occurrence. It is 
important to distinguish between validation errors and expression errors. Typically expression 
errors will require resolution by the form designer. A validation error is simply a false result from 
a validation expression, and is resolved by the form filler.

Shortcut
Toolbar:



We are constantly striving to improve the operation, versatility and user productivity of FillPower 
PRO for Windows. You may be interested in the latest program enhancements. You may also 
wish to license multiple copies and/or a Local Area Network version.

Call EZX/SSW at 1.713.280.9900 (FAX: 713.280.0099) for information concerning new features,
benefits, etc.. Be sure the registration card has been properly filled out and mailed in to us. As a 
courtesy to registered users we offer special upgrade pricing on all versions of FillPower.

If you have a registered version of FillPower PRO, be sure the registration card has been 
properly filled out and mailed in to us.
EZX Corp., PO Box 58177 - FIP96e, Webster, TX 77598-8177 USA

Special versions of FormPower/FillPower specifically tied to custom developed forms, are the 
“engines” that drive products like ExportPower™, PackageTrakker™, YourForms™, 
WinDD250™, WinSF171™, AnyPower™, MedPower™, ExpensePower™, etc. Call for details.

Should you require a special “sub-published” edition of FormPower/FillPower customized for 
you and your special form or application, contact EZX at the address and numbers below. 
Developers and VARs only, please.

For FAX-back information, you may call our FAX-on-Request systems 24 hours a day at 
1.713.280.8300.



A reminder for FillPower PRO TestDrive edition users that the program was developed at least 
one year ago. Certain features may now be completely disabled, but none of your forms will 
ever be lost. You just will not be able to save any new changes. THIS VERSION Of FillPower 
PRO HAS EXPIRED!

Call for latest information concerning product version, pricing and added features. We accept 
Visa, MasterCard, Discover and American Express via the phone.

We are constantly striving to improve the operation, versatility and user productivity of FillPower 
PRO for Windows. You may be interested in the latest program enhancements. You may also 
wish to license multiple copies and/or a Local Area Network versions.

Call EZX/SSW at 1.713.280.9900 (FAX: 713.280.0099) for information concerning new features,
benefits, etc.

If you have a registered version of FillPower PRO, be sure the registration card has been 
properly filled out and mailed in to us.
EZX Corp., PO Box 58177 -FIP96e, Webster, TX 77598-8177 USA

Special versions of FormPower/FillPower specifically tied to custom developed forms, are the 
“engines” that drive products like ExportPower™, PackageTrakker™, YourForms™, 
FillPower™, WinSF171™, AnyPower™, MedPower™, ExpensePower™, etc. Call for details.

Should you require a special “sub-published” edition of FormPower/FillPower customized for 
you and your special form or application, contact EZX at the address and numbers above. 
Developers and VARs only, please.

For FAX-back information, you may call our FAX-on-Request & Voicemail systems 24 hours a 
day at 1.713.280.8300.



Vertical Scroll bars

Vertical Scroll bars are positioned on the right side. Scroll bars are displayed at the right and 
bottom edges of the form window when the form exceeds the size of that window. The scroll 
boxes inside the scroll bars indicate your vertical and horizontal view of the form. You can use 
the mouse to bring other parts of the form into view.



The form orientation does not match the printer orientation
setting. Continue printing?
A form's orientation is chosen by the designer with the Form Layout command. The File Print 
Setup command allows setting of various print options, among them is orientation. When these 
orientations don't match exactly, this message results. It is possible to continue printing, but the 
resulting printout will probably be unusable.

Other problems can result when the paper size used in the printer does not match the size 
specified for the form. However these problems are less likely and probably more obvious.



Save this form before continuing.
Design mode

Changes are about to be made to the form in memory, so the current form must be saved. 

Fillout mode reads in the form in a specific manner to provide access to field data entry areas 
only. When completed, the form in the active window (memory) is saved to a separate file with a
.FOF file extension. With this method the master form is not modified and is available for future 
entries containing different data that may be saved to a different .FOF file.

Once saved, data entry fields in .FOF files may be modified at any time. This method may be 
used to clone new filled-out forms that may contain repetitive data.

Remedy

Save the form, then reselect the command.



What's New

FillPower PRO™ is the Ultimate Forms Filler for Windows!

NOTE: FillPower PRO™ is a subset of FormPower PRO™.
For more information, contact EZX Corporation at 713-280-9900    FAX:
713-280-0099.

FillPower PRO    Release 96d - Released March 1996

“PRO” features include:
• Extensive on-line help and MANUAL with BROWSE, TEXT SEARCH and PRINT. FillPower 
Help's powerful features (not available in “regular” Windows help files) will allow you to find any 
topic or phrase quickly. You will also be able to print any group of topics on demand. The unique
“tree” structure gets you to your information fast. You'll NEVER be without your manual again!
• Calculations - robust and “better than a spreadsheet”. 50+ field-oriented mathematical and 
logical functions are supported.
• Field Types: Character, Numeric, Date or Logical.
• Automatic field options include: Number (great for incrementing invoices, reports, etc.), Date, 
Time, Calculated and Remember. Override enable/disable is available too.
• Numeric field formatting with selectable number of visible digits and leading/trailing zero 
suppression.
• Field Pick Lists allow annotated data entry selections for real “no brainer” fill-out/in.
• Field Help allows the forms designer to input custom help for each field of the form - kind of 
like having the expert looking over the filler's shoulder.
• Field Validation assures proper data entry. Override (with customizable error message) is 
allowable if there are errors.
• Built-in support for MAPI (mail application programming interface) compatible E-mail 
(Electronic Mail).
• Enhanced dialog boxes with Tab select groups.
• Multiple Object Selection for fast movement and duplication of entire groups of objects.

New features in Version 1.30 Release 95h include:
• Support for international measurements and paper sizes.
    Window's international settings are monitored and the appropriate defaults 
    are used. (ISO paper sizes and metric mesurements, for instance)
• Unlimited character size for text objects. (Old limit was 256 characters.)
• Improved OLE functionality.
• Date and Time feed.
• Multiple copy printing.
• Graphics placement/sizing is faster.



Title Bar

The title bar is located along the top of a window. It contains the name of the application and the
active form.

To move the window, drag the title bar to the desired position.

Note: You can also move dialog boxes by dragging their title bars.

A title bar may contain the following elements:
Application Control menu button
Form Control menu button

Maximize button

Minimize button

Name of the application

Name of the form

Restore button



YourForms PRO      for Win Home/Office Inventory & Forms Developer!

YourForms PRO      for Windows 3.1+
Home/Office Inventory Application.
With YP End-user or Developer's Editions
We/You will be able to develop your own
automated forms applications WITH NO
PROGRAMMING. Sell them or give them away
without any further fees! WYSIWYG, icon forms
launch, multiple open forms, protected
fields, more. All Win printers.
EZX Corp. 713-280-9900    FAX:0099 BBS:8180 Tech:0080

* Doing Windows forms?

* Need to distribute a high quality custom FormPower PRO<tm> application?

* Read on!    If not, please forward to someone who does. They'll be glad you did!

    Y O U R F O R M S      PRO<tm>
* Turns your form (AnyForm tm) into your own "product" in minutes.

* Do you have a form (or forms) that you or your company fills out often,
    far and wide?

 Do your clients, customers, employees, or sales force cry out for automation?

* How would you like your own form(s) immortalized and distributed (if you wish)
    royalty free?

* Rejoice, YourForms PRO<tm> for Windows is here! ! ! !

- For a reasonable fee, EZX will design your custom form(s) to your satisfaction,
    and mate it (them) to a Fill-Only version of FormPower PRO<tm> called FillPower<tm>
    that is customized for you.

 [FYI: FormPower PRO<tm> is a general purpose FORMS PROCESSOR for Windows 3.1 that
    allows you to create, fill-in, fill-out, revise, file all kinds of forms.
    See detailed description below.]

- EZX will configure a custom installation routine, Windows program group,
    and icons tied to your form(s). This will make installation and use a
    certified "no-brainer".
- And the best part of it all is the purchase of a "YourForms PRO" license
    entitles you to distribute the program with your form to anyone,
    anywhere, without any additional fees or royalties.
- EZX "locks" the form(s) to your edition of YourForms/FillPower so that
    no-one else can access them, or make any unauthorized changes.
- YourForms PRO is available in single-machine use and network (LAN) versions.
- EZX will name the header on the program anything you wish, and have rights to.
- For an example of "YourForms PRO" type applications, see EZX's



    ExportPower, WinDD250 (Govt Form), MedTrakker, ExpenseTrakker,
    KidTrakker, etc. custom applications.
- For more details, and a price quote, give us a call or FAX.
    We'll respond immediately to discuss your application(s) in detail.
- We can usually turn around you custom order in less than a week.

- Contact Ed Marion at
    Voice:713-280-9900
    FAX:713-280-0099
    BBS:713-280-8180 (TestDrive and Catalog files available.)
    Tech:713-280-0080 (9:00am - 4:00pm      Central      M - F)
    Internet: ezx@cris.com    or    EZXHOU@AOL.COM

    EZX Corporation
“The Forms AutoMation Company”
    403 E. NASA Rd., Suite 377
    PO Box 58177
    Webster (Houston), TX 77598-8177    USA

Pricing for YourForms PRO End User Edition
! ! ! ! ! ! ! ! ! ! ! ! ! ! ! ! ! ! ! ! ! ! ! ! ! ! ! ! ! ! !

* EZX does all the work and gives you an installable diskette, ready to go.

* The first form, program and setup is $CALL (single machine) or $CALL (LAN).

* Each additional form page at the time of initial purchase is $CALL ($CALL later).

* If you want a "TestDrive" (DEMO) edition of your program, add $CALL at time of
    original purchase or $CALL later.

* Pricing includes all setup, design, scanning, shipping, and one year of
    priority technical support.

* Contact Ed Marion at    Voice:713-280-9900    FAX:713-280-0099.
    Internet: ezx@cris.com    or    EZXHOU@AOL.COM

more.....

QUESTION:
          Are you a developeror MIS professional who would like to create automated
          forms applications for your customers, company, employees, reps., etc.?
          Ask about the Developer's Edition of YourForms PRO. (See below.)

* Become a Forms Software Developer/Publisher

* ABSOLUTELY NO PROGRAMMING SKILL OR KNOWLEDGE IS REQUIRED.

* The ONLY ability you need to become a developer is to be able to design or
    scan forms. If you are familiar with Windows word processors and DTP your
    first form will take an hour or less.



* Congratulations, you're now a developer!

* With YourForms PRO Developer's Edition, You will be able to develop your own
    YourForms/FillPower type applications and sell them (or give them away,
    or use them in your company) without any further royalties or fees.
    You can change the name on the Program Group to suit the application.

* Cost is a mere $CALL one time fee and includes:
    - Your own custom coded version of FormPower PRO, which will create and/or revise
        forms designed by you and only you.
    - A custom version of FillPower PRO (both single machine and LAN editions) which
        you will be able to distribute with forms you create to your clients or
        within your organization. It will fill-out only your forms.
    - A custom "TestDrive" version of FillPower PRO that will enable you to distribute
        functional "demos" or "TestDrives" of your creations.
    - A Windows based installer that will allow you to make custom program groups,
        "no-brainer" installation, titles, icons, etc.
    - One year of priority technical support.
    - Reduced price applications development consulting.

* In essence, you will be in "competition" with us. But, you will be able to
    service your customers directly with backup from us, should you need it.

- Contact Ed Marion at Voice:713-280-9900 FAX:713-280-0099 BBS:713-280-8180 Tech:713-
280-0080
    Internet: ezx@cris.com    or    EZXHOU@AOL.COM



Edit menu commands
The Edit menu offers the following commands:

Cut Deletes data from the form and moves it to the 
clipboard.

Copy Copies data from the form to the clipboard.
Paste Pastes data from the clipboard into the form.

Delete Removes the currently selected text or object.
Undo Restores the last deleted text or object.

Fillout Next Fillout data fields in the current form
Text Feed-Time Place today's date into fillout field in form
Text Feed-Date Place current time into fillout field in form

Clear All Clears all text or all objects.



Field menu commands
The Field menu offers the following commands:

Pick Choose current field contents from a list
Help Display help for current field

Calculate Re/calculate current field contents
Validate Re/validate field contents

Date Place today's date into fillout field in form
Time Place current time into fillout field in form

Recalc All Reclaculate all formulas in the form.



File menu commands
The File menu offers the following commands:

Open Opens an existing form.
Fillout Fillout a form that contains data entry fields.
Close Closes the active form window.
Save Saves an opened form using the same file name.

Save As Saves an opened form to a specified file name.
Save All Saves all modified forms that have not yet been 

saved to disk.
Print Prints a form.

Print Preview Displays the form on the screen as it would 
appear printed.

Print Setup Selects a printer and printer connection.
File 1, 2, 3, 4 List of the four most recently opened forms.

Exit Exits FillPower PRO.



Help menu commands
The Help menu offers the following commands, which provide you assistance with FillPower 
PRO:

Contents Displays the help Table of Contents.
Overview Displays a quick FillPower PRO overview.

Using Help Provides general instructions on using help.
About Displays the version number of FillPower PRO.



Options menu commands
The Options menu offers the following commands which enable you to set default operating 
parameters for various features of FillPower PRO.

Preferences Program features.
Save Settings Saves settings after adjusting program 

defaults



View menu commands
The View menu offers the following commands:
View Scaling commands:

100 % View at full size..
75 % View at 75% of full size.
50 % View at 50% of full size.

200 % View at twice full size.
Custom % User definable view scale.
Custom % User definable view scale.

Refresh Updates the screen.



Window menu commands
The Window menu offers the following commands, which enable you to arrange multiple form 
windows within the main FillPower PRO program window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.

Arrange Icons Arranges icons of minimized windows.
Close All Close all opened form widows.

Window 1,2, ... Activates specified window.



The FillPower PRO program mode that allows creation and modification of Master Forms.



A FillPower PRO feature that creates objects. To place an object, first select a drawing tool, then
position the mouse pointer to where the top leftmost point of the object will be and press the left 
mouse button. Then continue to hold the left mouse button and drag the mouse pointer to the 
bottom rightmost point of the object. Finally, release the left mouse button. If snap-to-grid is on, 
the object's end points will automatically move to the nearest grid points.



An expression is a mathematical formula used for field calculations and validations. It is a 
combination of field names, operators, functions and constants that evaluates to a Logical, 
Character, Numeric or Date type.



A specific type of form, created with FillPower PRO from a Master Form. A unique Fillout Form 
file exists for each form that is filled out. All Fillout Form files have an extension of .FOF.



The FillPower PRO program mode that allows creation and modification of Fillout Forms.



A format contained in a file, which specifies how data is to be presented on the screen or printer.
Forms can contain data fields, fixed text, printing attributes and graphics.



A specific type of form created by FillPower PRO in design mode. A Master Form represents a 
blank form, to be copied and filled out time and time again. All Master Form files have an 
extension of .FRM.



The basic unit of a form. An object is created by a drawing tool in design mode, and is saved 
into a Master Form. Objects have attributes, and can be modified in various ways.



OLE is an acronym for Object Linking and Embedding. In short, OLE allows an object created 
by an OLE server (such as Paint, Excel, etc.) to be embedded into an OLE client application, in 
this case FillPower PRO. This very powerful feature allows placement of graphics, sound, video 
or other objects onto a FillPower PRO form.



In design mode only, to access this menu move the mouse pointer over an object and click the 
right mouse button. Continue to hold the button until you make a selection from the menu.






